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NovemberNovemberNovemberNovember    2007 2007 2007 2007 ----    Letter from the EditorLetter from the EditorLetter from the EditorLetter from the Editor    
Welcome to the six edition of the BetterSolutions.com newsletter. I must first apologise for there not being a 

newsletter or any website changes for the previous three months this was due to us relocating to a new office 

and also having a sudden increase in consultancy work. This edition however is our longest yet and we are 

keen to make up for lost time. We have concentrated on Office 2007 in this issue because there are a large 

number of changes and enhancements which users should be aware of. 

 

I would also like to wish all our clients and readers a Merry Christmas and best wishes for 2008, without your 

support and encouragement the website and newsletter would not be what it is today. The website is in its 

fourth year now and is proving to be a great resource for both reference and learning, with the number of 

visitor’s slowly increasing month on month. We are very pleased with the progress made but realise there is 

still a lot more to do. 2008 is going to be another busy year with our efforts focusing on our Utility Add-ins 

and SharePoint integration. SharePoint will provide us with a large number of benefits including discussion 

boards and document libraries. Just as the Microsoft Office applications have become the standard for your 

desktop, we believe SharePoint will become the standard for team collaboration. 

Microsoft Office 2007Microsoft Office 2007Microsoft Office 2007Microsoft Office 2007    
There are a number of changes in Office 2007 but some of the most significant have to be the Ribbon, the new 

XML file formats, the introduction of Themes and the new Smart Art graphics. The Ribbon is the area at the 

top of the application that replaces all the previous toolbars and drop-down menus. The Ribbon is organised 

into different tabs that group related commands together. The default file format is now XML although you 

can still save files in the binary format when you need backwards compatibility. A theme is a set of formatting 

specifications that can be applied to text, charts and objects to give them a consistent format. Themes can also 

be shared across your Office applications to ensure all your documents have the same look and feel. 

 

 

support@bettersolutions.comsupport@bettersolutions.comsupport@bettersolutions.comsupport@bettersolutions.com    
This email address is the one you should use when you have any problems or questions with Microsoft Office 

and you want some FREE help and advice. Sending us your questions will not only mean that you get a reply 

immediately but will also allow us to publish the answers in the next issue which will help other people as 

well. We spend a lot of time checking and testing the information to ensure that it is accurate but if you do 

spot any mistakes or anything that is wrong then please tell us. We are always looking for ways to improve our 

products and services and always welcome constructive criticism. If you have any comments or suggestions 

regarding this newsletter and the content contained inside it please tell us. 
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News and Related InformationNews and Related InformationNews and Related InformationNews and Related Information    

Microsoft Office Application Recovery (MOAR)Microsoft Office Application Recovery (MOAR)Microsoft Office Application Recovery (MOAR)Microsoft Office Application Recovery (MOAR)    
The Microsoft Office Application Recovery tool is installed by default and provides you with a way to 

potentially recover data when a Microsoft Office application stops responding. This tool is designed to work 

with Office 2002 and 2003 in conjunction with the Auto Recovery feature. The next time your Excel or Word 

stops responding this tool offers you an alternative to terminating the program using Windows Task Manager. 

The next time you have a sudden crash, select (Start > Programs > Microsoft Office > Microsoft Office Tools > 

Microsoft Office Application Recovery). This dialog box will display a list of all the Microsoft Office 

applications that are currently running and will list the status next to each one. 

Recover ApplicationRecover ApplicationRecover ApplicationRecover Application - This forces the selected application to recover any unsaved data, close and then restart. 

Any recovered files will be listed in the Document Recovery task pane when the application restarts. This 

caption changes to "Restart Application" for Outlook and OneNote. 

End ApplicationEnd ApplicationEnd ApplicationEnd Application - This forces the selected application to close without recovering any unsaved data. 

CaCaCaCancelncelncelncel - This closes the dialog box without taking any action. 

Please refer to the following knowledge base article http://support.microsoft.com/kb/292502http://support.microsoft.com/kb/292502http://support.microsoft.com/kb/292502http://support.microsoft.com/kb/292502 for more details. 

Office Office Office Office Migration Planning ManMigration Planning ManMigration Planning ManMigration Planning Manager (ager (ager (ager (OOOOMMMMPM)PM)PM)PM)    
This was first mentioned in the June 2007 issue and is a collection of tools that enable you to prepare for 

migration to Microsoft Office 2007. For the most part, documents created in Office 2003 and earlier should 

behave the same in Office 2007 however there will be a few instances where files might require some manual 

intervention or analysis to ensure consistent behaviour. The Office Migration Planning Manager contains the 

following: 

● Command line directory scanner that can scan files for potential issues and generate XML log files. 

● Utilities to help analyse and create reports based on the results from these log files. 

● The Office File Converter that can convert specific files to the new Office 2007 file formats. 

● The Version Extraction Tool that can extract the different versions embedded inside Word documents. This 

functionality has been removed in Word 2007. 

This collection of tools can also be used to identify all the Microsoft Office files that contain VBA code, 

although it won’t be able to help you with any macro conversion problems. 

Windows Windows Windows Windows Vista Vista Vista Vista –––– Program Compatibility Assistant Program Compatibility Assistant Program Compatibility Assistant Program Compatibility Assistant    
The Program Compatibility Assistant is an automatic feature of Windows Vista which detects known 

compatibility issues in older programs. After running this program you will be notified if there are any 

problems and what the suggested fixes are. If the compatibility issue is serious it might block or stop your 

program from running altogether. If this happens you can check online for possible solutions. This is not to be 

confused with the Program Compatibility Wizard (mentioned in the July 2007 issue) which can be run 

manually if you notice any compatibility issues. 

DisclaimerDisclaimerDisclaimerDisclaimer    
Better Solutions Limited is in no way associated with Microsoft Corporation. All the content in this newsletter 

and on the website is provided “as is” with absolutely no warranties. We strongly recommend that you back up 

all your data first before installing any updates or third party software. In no event shall Better Solutions 

Limited be liable for any special, indirect or consequential damages whatsoever resulting from loss of use, data 

or profits, whether in an action of contract, negligence or other action arising out of or in connection with any 

information published in this newsletter or on our website.
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Your Questions and ProblemsYour Questions and ProblemsYour Questions and ProblemsYour Questions and Problems 

 

Office 2007Office 2007Office 2007Office 2007    ---- W W W Why did Microsoft replace the toolbars with a ribbonhy did Microsoft replace the toolbars with a ribbonhy did Microsoft replace the toolbars with a ribbonhy did Microsoft replace the toolbars with a ribbon????    
Basically it was a combination of two things. Too many users complained about not being able to find the 

commands they were looking for and users were also asking for functionality to be added that already existed. 

It is easy to see how the number of commands has outgrown the original menu system and that more 

submenus and more dialog boxes was not the solution. The new user interface is task-based, presenting you 

with commands and options based on your current task. The new Microsoft Office System button appears in 

the top left corner of all the new Office 2007 applications and provides easy access to all the document specific 

commands. 

 

The new Ribbon interface has significantly reduced the number of dialog boxes you have to open to perform 

everyday tasks; however unlike the previous toolbars and menus this interface cannot be personalised. You 

only get one customizable toolbar and the more advanced features are definitely harder to find. 

 

Office 2007 Office 2007 Office 2007 Office 2007 –––– Do all the applications have this new ribbon interface? Do all the applications have this new ribbon interface? Do all the applications have this new ribbon interface? Do all the applications have this new ribbon interface?    
No. Not all the applications that fall under the Microsoft Office System umbrella have the new ribbon 

interface. Excel Word, PowerPoint and Access all have the new ribbon interface. Outlook has not been fully 

converted although the windows for creating an email and adding an appointment do have a ribbon interface. 

 

Office 2007 Office 2007 Office 2007 Office 2007 –––– Why  Why  Why  Why havehavehavehave Microsoft change Microsoft change Microsoft change Microsoft changedddd the  the  the  the default default default default file format to XML?file format to XML?file format to XML?file format to XML?    
All the applications in Microsoft Office 2007 are based on the new Open Office XML file format. By using an 

XML based file format it makes sharing, updating and reusing content extremely easy. It also reduces the file 

size and improves security and reliability. In Office 2000, Microsoft released an initial version of an XML based 

format for Excel. In Office 2002 a new file format for Word was released. These two formats were later 

incorporated into Office 2003 and known collectively as the Office 2003 XML formats. For more information 

please refer to the following article: http://office.microsoft.com/enhttp://office.microsoft.com/enhttp://office.microsoft.com/enhttp://office.microsoft.com/en----us/products/ha102058151033.aspxus/products/ha102058151033.aspxus/products/ha102058151033.aspxus/products/ha102058151033.aspx 

 

Office 2007 Office 2007 Office 2007 Office 2007 –––– Can I open the XML file formats in  Can I open the XML file formats in  Can I open the XML file formats in  Can I open the XML file formats in a a a a previous version?previous version?previous version?previous version?    
Yes, this is possible because the Open XML formats are backwards compatible with Office 2000, 2002 and 

2003. If you do not have Office 2007 installed on your computer then you will need to install the Microsoft 

Office Compatibility Pack for Excel, Word and PowerPoint 2007 File Formats. Once this compatibility pack 

has been installed you will be able to open, edit and save files in the new Open XML file formats from within 

Office 2000, 2002 and 2003. This compatibility pack can be downloaded free of charge from the Microsoft 

website. 

 

There is also a Microsoft Office Isolated Conversion Environment (MOICE) tool that can be downloaded in 

addition to the Compatibility Pack. This tool was previously mentioned in the May 2007 issue and can be used 

with Office 2003 and 2007 to convert files from the old binary file format into the new XML file format. 

Converting files in an isolated environment provides a way or pre-processing any potentially unsafe binary 

files. MOICE currently supports the following document formats: .doc, .ppt, .pot, .xls, .xlt, .xla. To Install 

MOICE, you must have the Compatibility Pack for Word, Excel, and PowerPoint 2007 File Formats installed. 
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Office 2007 Office 2007 Office 2007 Office 2007 –––– New Features & Improvements New Features & Improvements New Features & Improvements New Features & Improvements    
 

Excel 2007Excel 2007Excel 2007Excel 2007    
One of the biggest improvements has been to the size of the worksheet. You can now have up to 1 million 

rows and 16,000 columns. Users no longer have to work on multiple worksheets or in other applications when 

they need to analyse large amounts of data. Conditional formatting has been improved and three new 

visualisations have been added (data bars, colour scales and icon sets). Tables have replaced lists and table 

headings replace column headings automatically when you scroll large tables. You can now sort on multiple 

columns and sort by colour or icon set. Table formatting has been improved with the new cell styles and the 

charts have a much better finish. The new Page Layout view displays your worksheet in a view that displays 

the print area, margins and ruler as well as making headers and footers a lot easier to work with. There is also a 

completely new interface when working with pivot tables. 

 

Word 2007Word 2007Word 2007Word 2007    
The introduction of Live Preview combined with the concept of Themes has to be one of the most significant 

changes not just in Word but in the other applications as well. Users are now presented with a clear set of 

possible formats, rather than a complicated dialog box with numerous options. Using galleries in conjunction 

with styles has simplified the process of creating professional documents leaving the dialog boxes for those 

who need greater control. Adding footnotes, citations and references is now a lot easier and the mail merge 

functionality has got a completely new interface. The equation editor has been replaced with a new integrated 

Equation Tool and the mail merge functionality has also got a new interface. The new Document Inspector lets 

you easily remove hidden or unwanted metadata and the new Building Block functionality gives you the 

ability to quickly reuse content. Microsoft also provides an add-in that can be downloaded to allow documents 

to be saved and exported in PDF format. More on this particular feature in the next issue. 

 

PowerPoint 2007PowerPoint 2007PowerPoint 2007PowerPoint 2007    
The most significant changes in PowerPoint have been to the 

Smart Art graphics and charting features. Microsoft Graph has 

been removed and has been replaced with fully integrated Excel 

charts. The diagram features have been completely re-written 

with additional diagram types plus the formatting and the 

overall finish looks a lot more professional. There is a new Slide 

Gallery to enable you to save and reuse your favourite slide 

layouts and finished presentations. There is a new Presenter 

view as well as support for custom layouts. You can now even 

select discontinuous text by holding down the Ctrl key. 

 

Outlook 2007Outlook 2007Outlook 2007Outlook 2007    
Outlook still contains the earlier toolbars and menus but the new ribbon does appear when you create a new 

email or add a new appointment. Don’t be fooled into thinking that not much has changed though; there have 

been significant improvements below the surface. The most significant are the To-Do bar, attachment 

previewing, instant search and email colour categories. The To-Do bar displays your calendar, appointments 

and tasks all in one panel down the right hand side. Certain file type attachments are now viewable from 

within the previewing pane of Outlook so you don’t have to open them in a separate application. There is a 

new category colouring feature to help you locate, manage and prioritise your emails as well as improved 

filtering on the Junk Mail folder. 
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Excel Excel Excel Excel 2007200720072007    ––––    Office ButtonOffice ButtonOffice ButtonOffice Button 

Using the Office ButtonUsing the Office ButtonUsing the Office ButtonUsing the Office Button    
The File menu in all the previous versions of Office contained the commands for basic file operations 

including New, Open, Close, Save, Print etc. In Office 2007 these commands can all be accessed from the new 

Office Button which can be found in the top left corner of the 

application. The Office button is present in all the Microsoft Office 

2007 applications and provides a 

central location for all the 

commands that relate to the 

document you are working on. 

Hovering over this button with 

your mouse will display a large 

screen tip. Clicking on the Office 

Button with your left mouse button will display a large panel that 

resembles the old File drop-down menu. This panel is divided into two 

parts. On the left you will see all the familiar commands. Some of these 

are buttons and some are buttons with extension menus. The panel on 

the right will change automatically depending on which command on the 

left you select or hover over. 

 

The Recent Documents panel is displayed on the right initially when you 

first click on the Office Button. You can make sure files that are 

frequently used are always listed by clicking the pin on the right. 

 

The “New”, “Open”, “Save” and “Close” commands are buttons that can 

be quickly pressed. The “Save As” and “Print” commands are buttons that 

can be quickly pressed plus they have an arrow next to them. This is a 

little confusing because an arrow in previous versions has indicated an 

extension menu. Hovering over the “Save As” or “Print” command (as 

opposed to clicking on it) will display the corresponding commands on 

the right giving you more options. If you want to see the additional 

commands but don’t want to waste your time hovering over the 

command you can click on the arrow instead. 

 

The file extensions have changed in Excel 2007 but most of the 

commands are the same. I am sure for most of us the transition from Excel 

2003 to 2007 is going to be slow, so the best file format to use when 

saving your files is going to be the “Excel 97-2003 Workbook” option. 

Saving your files in this file format will ensure that other people will be 

able to open your files in earlier versions without any problems. 

 

You will also be pleased to hear that the “Print” button on the left 

displays the Print dialog box as opposed to the Quick Print button. In 

Excel 2003 we had a Quick Print button on the Standard toolbar which 

was often pressed accidentally. 
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The Prepare extension menu displays options to let you inspect, protect, 

sign and finalise your documents and the commands are consistent in all 

three applications. The “Prepare”, “Send” and “Publish” commands are 

just extension menus as you would expect and clicking on them displays 

the additional commands on the right. All the commands on the 

“Prepare” extension menu are new except for Properties. In Excel 2003 

the document properties dialog box was accessed using (File > 

Properties). In Excel 2007 these properties are now displayed in a new 

Document Information Panel at the top of your document. You can 

access the old File Properties dialog box by selecting Document 

Properties at the top and choosing Advanced Properties. 

 

 

The “Inspect Document” command provides a central location for you to examine documents and remove 

sensitive information. Sensitive information that you might want to remove could include: comments, 

annotations, document properties, hidden rows and columns, hidden worksheets and other invisible content. 

The Document Inspector can also identify problems with your headers and footers. 

 

The “Encrypt Document” command allows you to quickly add a password that is required to open a document. 

In Excel 2003 this could be achieved in a number of different ways including from the (Tools > 

Options)(Security tab). This option has been removed from the Excel Options dialog box in Excel 2007. If you 

want to add a password to modify a document you need to use the Save As dialog box and select (Tools > 

General Options). 

The “Add a Digital Signature” command allows you to add a digital 

signature to a document as a way of verifying a document’s integrity. An 

invisible digital signature is not visible within the contents of the 

document itself, but recipients of the document can determine that the 

document has been digitally signed by viewing the document's digital 

signature or by looking for the Signatures button on the status bar at the 

bottom of the screen. 

 

The “Mark as Final” command gives you an easy way of preventing 

changes to a final version of a workbook. This will automatically make 

the file-read only as well as disabling all the editing commands. This is 

not a security feature as it can be easily switched off but more of a way of 

preventing accidental changes. 

 

The “Run Compatibility Checker” command will check your file for 

anything that might not be compatible with previous versions of 

Microsoft Office. For example any Smart Art graphics will be converted 

into a single object that cannot be edited in earlier versions. 

 

The “Document Management Server” enables you to save your document 

to your own document server. This will display the Save As dialog box 

defaulting to My Network Places so you can quickly upload the file to 

your server space. 

 

The “Create Document Workspace” displays the Document Workspace 

panel where you can enter the URL of the workspace you want to create. 
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Excel 2007 Excel 2007 Excel 2007 Excel 2007 ––––    FormulasFormulasFormulasFormulas Tab Tab Tab Tab    
This is one of the tabs that will be used the most and you will be pleased to hear that not much has changed. 

The most noticeable change will be the new Formula Auto 

Complete. When you start typing a function into a cell, you 

will see an auto complete drop-down list of every function 

that starts with those letters. You have still got the Analysis 

ToolPak add-in which can be loaded but all the worksheet 

functions are now installed by default. Twelve new worksheet 

functions have also been added. 

 

Function LibraryFunction LibraryFunction LibraryFunction Library    
The Insert Function command displays the familiar Insert Function dialog box and apart from an additional 

“Cube” category nothing has changed. The AutoSum is a button for those quick summations and is also a drop-

down list when you want to use a different function. They have also removed the Auto Calculate functionality 

from the status bar and 

replaced it with 

permanent Average, 

Count and Sum totals. 

This can be a great time 

saver when you are analysing large amounts of data. The Recently Used drop-down list is a bit more useful 

than it was in Excel 2003 because it remembers your functions not only when you use the Insert Function 

dialog box but also when you use one of the category drop-down lists. The other six category buttons list all 

the functions in that category in alphabetical order. This is definitely a big help. The Information, Statistical, 

Engineering and Cube functions can all be accessed from the “More Functions” drop-down list. The help 

provided for these functions is still very limited and they seem to have forgotten to include a “Database” 

category drop-down. Maybe it will appear somewhere else. 

 

Defined NamesDefined NamesDefined NamesDefined Names    
A new Name Manager dialog box has been added to replace the old (Insert > Name > Define) dialog box. This 

new dialog box lists all the named ranges (both workbook and worksheet) 

and also lets you quickly add, find and delete them. You can make multiple 

selections as well as sorting on every column. We were tempted to include a 

Named Range Manager tool in one of our Utility add-ins but that may not be 

needed now since this new dialog box provides all the necessary 

functionality. 

 

The Define Name dialog box has been replaced with a new “New Name” dialog box. This allows you to quickly 

define the level of the named range and also includes a box for additional comments. Any comments you do 

include will be displayed as Auto Complete tooltips when you are entering your formulas. All the dialog boxes 

can be resized making named ranges a lot easier to manage. The “Use in Formula” drop-down makes it a lot 

easier to insert named ranges into formulas and also gives you access to the previous (Insert > Name > Paste) 

dialog box. The “Create from Selection” lets you create named ranges automatically based on the values in the 

selected cells. This replaces the old (Insert > Name > Create) command. The (Insert > Name > Label) command 

is no longer available since Natural Language Formulas have been removed in Excel 2007. 
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Formula AuditingFormula AuditingFormula AuditingFormula Auditing    
This command set contains all the commands from the Formula Auditing toolbar and the functionality has not 

changed at all. The “Remove Precedents” and “Remove Dependents” commands have been moved to the 

Remove Arrows drop-down list and the “Trace Error” has been moved to the “Error Checking” drop-down list. 

The New Comments button has been moved to the Review 

command tab. The Evaluate Formula and Watch Window 

commands are very useful and are now in much more 

prominent positions. The Watch Window lets you monitor 

(or watch) the values in other cells and ranges while you are 

editing and is definitely a feature that is not used enough. Circular References have been moved to the Error 

Checking drop-down list. If your workbook contains more than one circular reference you will only be told 

about them one at a time. Any circular references that exist in your workbook will be automatically 

highlighted with a Blue arrow. This functionality is exactly the same in Excel 2003. 

 

CalculationCalculationCalculationCalculation    
The Calculation Options drop-down provides a quick and easy way to toggle 

between Manual and Automatic calculation. The calculation options can still be 

accessed from the (Excel Options > Formulas tab). The number of iterations can 

only be changed from the Excel Options dialog box. The “Calculate Now” and 

“Calculate Sheet” buttons are a great addition and the (F9), (Shift + F9) and (Ctrl 

+ F9) shortcuts obviously still work. 

 

New Worksheet FunctionsNew Worksheet FunctionsNew Worksheet FunctionsNew Worksheet Functions    
Excel 2007 sees the introduction of 12 new worksheet functions and the most significant addition is the 

IFERROR function. Previously if a user wanted to catch an error they would have to use a combination of the 

IF and ISERROR functions. 

AVERAGEIFAVERAGEIFAVERAGEIFAVERAGEIF – Returns the average of all the numbers in a range of cells that satisfy a condition. 

AVERAGAVERAGAVERAGAVERAGEIFSEIFSEIFSEIFS – Returns the average of all the numbers in a range of cells that satisfy multiple conditions. 

COUNTIFSCOUNTIFSCOUNTIFSCOUNTIFS – Returns the number of cells with a value that satisfy multiple conditions. 

IFERRORIFERRORIFERRORIFERROR – Returns a value or if that value generates an error it returns a different value. 

SUMIFSSUMIFSSUMIFSSUMIFS – Returns the total of all the numbers in a range of cells that satisfy multiple conditions. 

 

There are also 7 new cube functions that can be used to return data from Analysis Services cubes. 

CUBEKPIMEMBERCUBEKPIMEMBERCUBEKPIMEMBERCUBEKPIMEMBER – Returns a key performance indicator (KPI) property and displays the KPI name. 

CUBEMEMBERCUBEMEMBERCUBEMEMBERCUBEMEMBER – Returns a member or tuple from the cube. 

CUBEMEMBERPROPERTYCUBEMEMBERPROPERTYCUBEMEMBERPROPERTYCUBEMEMBERPROPERTY – Returns the value of a member property from the cube. 

CUBERANKEDMEMBERCUBERANKEDMEMBERCUBERANKEDMEMBERCUBERANKEDMEMBER – Returns the nth or ranked member in a set. 

CUBESECUBESECUBESECUBESETTTT – Defines a calculated set of members or tuples by sending a set of expressions to the cube which 

creates the set and then returns that set. 

CUBESETCOUNTCUBESETCOUNTCUBESETCOUNTCUBESETCOUNT – Returns the number of items in a set. 

CUBEVALUECUBEVALUECUBEVALUECUBEVALUE – Returns an aggregated value from the cube. 

 

FormFormFormFormulas Tab Summaryulas Tab Summaryulas Tab Summaryulas Tab Summary    
This tab is definitely well organised and has everything you should need for working with formulas and 

functions. The most significant changes are the quick access to the functions listed by category, the new Name 

Manager dialog box and of course the new IFERROR worksheet function. The missing Database functions 

category is a mystery but I am sure there is a reason it has been excluded. 


